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1. Abrindo o TestComplete

| — Localizando e abrindo o programa

Clique na barra de pesquisa do Windows e escreva “TestComplete”.

| Bteltvor carrespondénca

Pesquisar na Web

52 testcomplete - Ver resultacos da Wob H

L testcomplets downboad ¥
2 testcomplete tutorial ¥
' testcomplets smartbear >
| O testcomplete documentation y
: £ testearnplete 14 »
£ testeornplete tool 3
£ testcomplete software 3
Comarndo
B testcomplete ¥
DOocumentos
B TestComplete - juliorar b
" (Getting Started with TestComplete: >
A2 testoornpeeted 11

Clique para abrir o programa.

Il - Carregando Script

Com o programa aberto, va em File logo apds Open, navegue até o enderego

de rede: \Serversat\sat\Testes\TestComplete

Obs.: Para entrar no Serversat, caso pegca o dominio o login é “Teste” e a

senha “S@T123456”
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B open Project w

L “ [ L5 Rede s perversst o SAT & Testes s TesiComplete & LI | Faymuivir TetComplete e
Organizar = Hewa pasta F 1 @
3 X t -
BB Livks pava Apiicativg Mamt . Dats de modficacts Tipa Temanks
|| BATEmbsasDePagaenentos 0370, 1000 1438 Pasta de niguince
& Onelrive || SATDigitarRelstoraDebdontagem SLR 12 Pasts de arquios
B Este Comp ’ I_z SaTDigitarBalango 2050 1108 Pasty de u.rm.l.r\.m
Arg _ | SATradosPemContabididade 15062021 S Pasty de prguives
F A Rkl || SATCotacsaDePrmcos ISTAZ021 1D L —
4 Documentos || stTContrefeDeProduces Y 270 B Pasts e prquima
& Downlosds || SATContrchellehbesas TR B2 Pasta e oo
[ Imsigens || SHICenteCaminies DRI TN Pranks da wiguives
J masicas [ saTcontasseeber e TR Pasta de arcpibica
2B Chjetos 30 I__I SATCantastPager (08 2001 Dy Pasts de anguives
X | EATC ikafelscrioDeddentagem 2N A 12T Pasts de srgurics
B videos
4 Bisco Liscal | SATConsukadfeletorioDefntraga T i 1200 Pasts de atquios
b Digen Loaal{C] || SATConsulmPedidosParaFomecedar 1/ BE021 0231 Fuacts de sipurios
= Movo volume: [y || saTCansmmPedisa 2740572021 0258 sk e epivn
b Rt | SATConmibmNalaFical T2 14 Paita de srureen
gl g il >
o | ] mpirie Cajrma |

[ Abew | | Concelar

Selecione o modulo desejado e abra a o arquivo de extensao “PJS”

B cpen Project s
L2 “ | o RATFeenscedares ¢ SAT Formecedores 2105200 - [} Fanauiiter B0T Foenecedorss . 0
el " b el I AT

Organizar = Hewa pasta E A @

“ )

B Lisiks e Apsicative Mo Dats de modficacia Tipo Tenanha
T ¥

& Onelvi 13T 202 T T Paste de arporics

JUOEE0 T Pacti e npiin

B Esfe Computadar
B Area de Trataiho |
g Documentos
4 Dovnlosds
= Iragine
J tadsicas
B Otjetoz 3D
B videes
ey Bisce Local 4ty

Nome | SaTFomecedores.pis “ A ProjectFiles (" gjstmd |

Obs.: Como boa pratica orientamos duplicar a ultima pasta, a que esta com a
compilacdo mais recente. Renomear a versao para a compilacdo que sera
testada. Desta forma mantemos o arquivo anterior sem alteragbes e podemos
altera-lo de acordo com a necessidade.
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O Script sera carre

ga

sfesiTest

do no programa

e Gt v Tt e ot -
e BDRB-OC HINT  RRE-BB- @ F - - e

Froject Workepaos bt Brovyer
[ froject Exporer P08k | [ Workepace

BAERE A G- M v

T 8 Project Suste SATFeCocore (1 gropct)
[ saTror
v 3 hdverond
» [ events
o [ st @ RecorD TEST %
w55 0 - Tesben Bisicoa
(B Tests 28 00 e
w |3 18k - Dades do Fomecedor
[ Tiewte_015 00 Privvesis_Anticr
[By Teste 0% o0 Cancatar
[ 53 Teste 07 00 Bkt
[T Teste 08 00_Trseri_Sabvar
[y Teste 05 00 Ewcr
[ Teste_10 00 _Ahsskrar
[ 35 Testa_11_00 Prodsar
Tesie, Jrrpemir
%rnuj:i Log Getting Started
[B Teste_14 00 Fechar
w |5 2 8ba - Erderegn
E:::-:ﬁ-“m“za Laarn Marg: >
[ 7 Tesbe_17_ 00 Presncher_Campa_cee
v (B3 3 by - Ctresrvacnes
[By Teste_1s 00 Dbsarvacoes CORRSCAD
~ [ 48k - Contabd
[ Teste_13 00 Cosen Cordald
~ [ 5 Aba - Banco de Dades
[ i Tesbe 2% 06 CrisrCampos
52 KeyworaTests
[ Hamestapping
[ TestedApes
[ sar
“o il Proect Suite Logs
lﬁSﬂFﬂﬂlﬂmhw

FMARTAEAR

& TestComplete. e

Create your first test with TestComplate

Web Testing Basics

2_.Executando o Script

| — Abrindo o roteiro de Homologacao

Para que saibamos o que se esperar dos testes automatizados, existem os
roteiros de homologagao, sdo documentos onde todos os testes estéo listados
com o que se deve fazer e com o resultado esperado.

Acesse a pasta e escolha o roteiro desejado:

\\serversat\sat\Testes\Roteiros VCL - Web

Obs.: Para entrar no Serversat, caso pegca o dominio o login é “Teste” e a
senha “‘S@T123456”

Obs.: Como boa pratica orientamos duplicar o ultimo arquivo, o que esta com a
compilacdo mais recente. Renomear a versao para a compilacdo que sera
homologada. Desta forma mantemos o arquivo anterior sem alteragdes e
podemos altera-lo de acordo com a necessidade.
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[ LI [4 ] = | SATFornecedores - O >
Arquivo Inicio Compartilhar Exibir - 9
* % * o Mover para = | X Excluir = ‘i v E—‘L i EH
: = W 253 N [ el
nceif:‘,;:gdu Copiar Colar IE ”—f'-l Copiar para ~ Eﬁ Renomear ;laus'l;: Pru-pn:dades & SEiec:unar.
Area de Transferéncia Organizar MNovo Abrir
. T8 Rl | D, « Roteiros VCL - Web » SATFornecedores v O = Pesquisar SATForn...
| | SAT- Treiname # ®  Nome Data de mﬂ}ﬁﬁﬁu‘. .V Tipo
|| 202108 113 SATFornecedores VCL_ 2105204 07/07/2021 12:45 Documenta da I
|:|!| Ad @ SATFornecedores VCL_210507B-WEB_210...  16/05/2021 15:06 Documento de M
|:|!, SATConfigurarMot IE SATFornecedores_210303A 19/04/2021 16:55 Documento do I"n"l
I:I!I xml's teste @ SATFornecedoresWeb + VCL_2012144 09,/04/2021 11:19 Documento do Mi
@ SATFornecedores_200G044 08/11/2020 09:00 Documento do W
& OneDrive 33 SATFornecedores 2003174 07/04/2020 11:09 Documenta da v
[ Este Computador @ SATFornecedores_2001174 30/01/2020 14:37 Documento do M:
B Area de Trabalho @ SATFornecedores_191120B 20/11/2019 14:34 Documento-do V)
f T @ SATFornecedores_1911134 13/11/2019 1117 Documento do W
IE SATFomecedores_1908168 16/08/2019 10:46 Docurmento do V)
& D em DESKTOP-O 033 SATFornecedores_190708A 08/07/2019 17:26 Documento do IV
==| Documentos @ SATFornecedores_190603A 06/06/2015 11:20 Documento do )
& Downloads 03] SATFomecedores_1811054 03/11/2018 16:22 Documento do M
f E em DESKTOP-0O( @ SATFornecedores_ 1805024 13/10/2018 1207 Documento do M
&1 Imagens
b Misicas
_J Objetos 3D
B videos
e Disco Local (T}
- DADOS (D)
v < I 5
14 itens B2l =]
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Il - Executando os casos de teste no TestComplete

Agora que ja temos o Script carregado no programa e o roteiro aberto, € hora
de iniciar os testes. No programa TestComplete foi adicionado scripts a partir

do Teste 04, pois os demais sao padrdes para todos os modulos.
Abrir SAT | Atualizar arquivo pela rede | Atualizar arquivo pelo FTP
Para sua execugao € necessario que o SAT esteja aberto
Matricula: 1236

Senha: Suporte

Dé um duplo clique no primeiro teste — Teste 04

i Fie Edit View T Debug Teol Help =
- BRBCOC RADT - GRE - BB @G- T

. Progect Workepace [ibpact Browemsr

i -fcﬂnuth Zeghy

%@ @

[ #ropect Bxplores 209 % [ Wk
@-'_i-l." I@_@‘ﬁ' Pt siwtpage % [ Teste_oe00 a0 %
w o e 1 L - || . — 3
" Project Suite ‘SATFwnecedores (1 o) i EE= N e
w (7. saTromecedores Ei‘———% S o *r
w [53 Advanced TTIPrOCERUrE TESEL
3 [%Events 3 begin
] Aliases . SAT. wndFrodain.Maintenu . Click( Cadastras| [9]"};
- raé;w ] allases . SATFornecedores . wodFraFornecedores ClEck (387, 18);
o & - Teutes Bisooa 5 endy
[Byfrests 24 00 sber | 1k ]
b 1 &b - Bados do Fomeosdor rd El |procedure Test?;
E’[&T P et war wlFrmiain = Olevariant;
A 95 01 A 0] war wdFrafrodutos @ OleVariant;
LBy Teste o _o0_Cannetar 24 begin
Eafuu_a?_mm 5] wrdFrofain t= Alisses.SAT.wndFroMaing
[hmu_m_m_nm_sm ] wrdPrmtain, Click (385, 15);
[FS Teeshe_ 0%, 00 Sxchr B | | wndFrafain, Malntens. CLick( ' Cadastros|[10]7);
L}T'Hh_.m'_ﬂ Atdhear 14 wdFraProdutas == Allsses SATProdutos. madFraProdutas;
& - a wrdFrafrodutes . Close )
Testa_L1.00 Procurar =) wodFratiadn, Panel. btaProdutes clickButten)
Eémmmmm A || wndfrefrodutes, Close;
[Faeste 1500 Log 18 ends
[By Teste_ 14 o0 Fechar

~ 5 24ba - Enderern
[ Temta_t5 00 _Trarspertaders
[By Teste_15_00 Pemissoes_Para_Fornecedores
[ Teste_17_00_Presncher_Campo P
~ [ 3 Aba - Dliservacoes
[By Teste_ 13 00 Dbcsrvacoes CORRECAD
w [£3 5 aba - Contishi
(B Testa_15 00 Cosiga Coetatsi
5 5.4ba - Banco de Dadas
[y Teste_20,00_ Snartiamoos
52 KaywordTests
[ HemeMzopng
[ Teshednpos
Baar

w fHe project Bute Logs:
1 B TFormecedores Logs P Tamt v krar
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Sera carregado o Script do lado direito, apds carregado clique no botdo “Run
This Rouline”

SletPage [l Teste 04 00_pbir

EESES 5 &Sdam - @
[:ri:-nedur! 'I'E:t:l:j o . -

& begin

fal Aliawes, SAT wndFrebain. Mainteny, Click( " Cadastros | [R1713

) aliages. SATFornecedores. wndFreFornecedores (Click{ 307, 18);

i Endy

5
=3
rd = |procedure Testd;

3 war wndFrmiain - DleVariant;

] war wndFreProdutos @ Olevarlang;

L] begin

1 wndFradain te Alisses . SAT.wndFrofaing

wodPrmtadn, Click{I6%, 15);

wrdlFrmtiain, Hainkenu, Click( "Cadastres |[18]");

4 whdFraProdutos o= Allaces SATRProdutos. whdFraeProdutos;
wrdFrefrodutos . Closs:

wrdFratadn . Panel. btnProdutos . ClickButton)
wralFreProdutos, Closs;

bk | |end;

Verifique se o “Resultado Esperado” informado no roteiro de homologagéo foi
alcangado ao final do Script.

No programa TestComplete também verificamos o éxito do teste através dos
Logs, além disso temos também o “Test Visualizer” abaixo do Script que
mostra as telas e cliques gravados.

Grmeesie 7 x| [
1 s -, x
YA R P Stwtpae x| [l Tt 04008 % B soioiTestlog Meste 0400 6r., %
- tSite SATFomecedoEs (1 = mEesas T = ]
P:Hﬂﬁ:nmm e IR EZES paerl -IMEG
o [E5 Acbenoent 3 D |procedure Testl; ) )
# [ Events i Brgin
sl Allases SAT wndFraain. Meintenu, CLick{ Cadastras | [9]7);
" E'i;b’r = 2ilases. SATFarnecedares wndFrafornecedones C1Eck(307, 18);
-4 0 - Testes Risiss |5 end:
(2 Teste,_ 04,20, gber B

~ (5 1 tbe - Dietlos do Fomecsdor
[ Tiesti 35 00 Prieseieis_antesiar
LBy Teste 06 00, Carnetar
[y Teate 07 00 pater
[ Tests_08_00_Tnser_Sabvar
LBy este_o5_po sxcr
[ Teste_10_00_thusinsr
[Ty Teste_11.00 Froccer
[Py Teste_12 00 mmprime
[ Teste 13,90 Log
[Py Testa_t4 00 Fechar
~ [ 2 abe - Enderepm
[ Toesbis_1.5_00_Travmper tackers
[By Teste_15 00, pemmissoes_fara_Fornecadares

[ Tosta_19 00 Codign, Connabsd
~ [559 5 Aba - Banco de Codes
[ Teste_0_00 Crertampos
(52l KnwereTests
(43 Hamamzzpng
v [ Testedigps:
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3.Corrigindo o Script e adicionando
novos teste

| - Corrigindo o Script
Ao executar um teste pode ser que

0 “Resultado Esperado” n&o seja

alcangado, verificamos no programa TestComplete desta forma:

Prosect Workenass  Ghrjact Browser

[ frapeet e 1095 | [ Worlmeee _
S A R P SiwtPage X [ Teste 04.00 a6 % B Sciot TestLog [Teate 0400 Abe.., 3
—
i Project Site SATFornecedores’ (1 oraject) | Goto et Emor = Create fra lssue = Salect -
s e K e @ b v [T € Creme sl ~ JE L = = Barel
B adaanced Log e | Testiog
b [ Evens | @smiresticgirete ot ] @ Flener 4 Fwenne S Tivemwme b Foer @ 7 chedoont
- [z T
VBE:::MM E&ar e e e B E Ao s
5 1 Aba - Dtz o Pomecerder Q) [The test nvhes stopped becouse your test project i configured torstop on o

[ Tiestn_05_ 00 pramsinn_sntarer
[ Teste 96 00 _corcelar
[ Teste 07 00 _Bdkter
[Ba Teste_0: 00 Tnserv._Sabvar
[Ty reste o9 00 ke
(B Teste_10_00_thaskrar
[y Teste_11_00_ Proasar
[F Teste_t2 00 _tmprrne
[ Teste_13.00 tem
[y Teste_14_00_Fechar
~ [£5 2 2ha - Enderegn
[y Teste_15.00_Trarsportadorn
[By Teste_te_00_penmissans_pars_Formscederes
[ Teste_17 00 Presncher Campo P

[T Tieste_19.00_Cokios Coritabd
~ (555 5 Aba - Banco da Dades
[l Teste_a0_00, €rertampos
[53 KaywondTeats
17§} NameHapping
v [ Trstedipos
(B
w7 rogect st Logs
- @- SATFomecedores Logs
& soript TeatLeg [Taste o4 00_AbreTestd] DS/05/202L 19:24:08

3 oot TestLog [Teste 04, 00_sbrresti] D6/08/2021 19:32:2%

Fichre  Dels  CaliStac

Bred Teme: O5/GE202 1 1932
flun Time: Go0i0L

Sl Tevad: 06082071 19:32

Total rumiber of items: 17.

Tested object:
S5 Process [ SAT ) Window( TFrmbain', ‘SAT Sistema de Automagio Total vers3e 2106208, T)MainMent:

O Log e Test Log ficam em vermelho.
Isso pode ocorrer com a mudanga de um layout, mudan¢a do nome de um

componente, entre outros.
Para corrigir deveremos regravar o

teste.
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Selecione e delete o conteudo do Script

EET WOnERacE | Ohject Browser -
T Project Bxplores P05 % | [ Workepeoe - .
BLERB%- B stactpoge % [ Teste 04 0000 * % | B St Test Log Meste 04,00 Abe.., X
,.E.Ezmgmx:mm IFE EEED 5 &S R Bk 4=
vam-u e e e ey
» [k Events

Selecione o contetde = aperte a tecla Delete ou
[Ra e 95_00_Prase_Aatesor Backspace até deixar o formuléario em branca.

[l Tests,14_06,_Fechar
¥ 5 2abe - bndere
[l Teste 15 00 Trarspertadors
[By Teste_15_00_Pemissots_Pars_Fonecedares
[ Teste_17_00_Fresncher_Campa_CrF
B3 3 80 - Clivervacons
[y Tests_15 00 Cboervacnes COARECAD
~ 5 4 8o - Contabd
[ Teste._15_00_Cocsgo._Cornati
~ 3 5 aba - Banca de Tade
(B Peste_0 00 Crertamoos:

[ Hemettzpang
[ Testedioos
Ssar

Agora com o script em branco, clique em “Record Script”

- BERB-OC XOBT-Ges -eE|e|s man-

Frect oo | oo trouer \
[q rokcttmos 28X ([ worepee =

SRR AEGS-
~ R® Project Suite ‘SATFornecedores (1 praecs)
~ i sATrormecedores
v [ hebvanced.
» D Events
[ 5oet
50 -Testes Risiesn

* (3 18ba - Dedos do Pomecedor
[ Toate 05 00 privaiee._sntivier
[y Tests 05 00 Cancelar
[ Peste.017_00 Ecir
[T Teste 25 o0 Inserr_Saar
[ Teste o3 o0 Sxcir
[ Peste_10_t00_Abasioss
[Ty Teste_11_o0 Proasar
[ reste_12 o0 amarimic
[ reste 13,00 1op
[By Teste_t4 o0 Fechar
~ 5 28ba - Enderegn
[ Teste_15_00 Trarmporsatorn
P RS AL A B

Uma pequena tela sera aberta selecione o teste em questao e clique em OK

[y Teezte_0%_00_Preer_snterior
[ Tests_06_00_Cormcaiar

[y Teste_07_00_Edear

(g Teete_08_00 Insere_Sebvar
[y Teste_09_00 Bk

[ Teste_10_00_& huatar

[ By Teste_13_00_Procursr

(B Teste_17_00._Treprimir

[ Teste_13 00 1o

[ Teste_14_00_Fechar

[T Teste_15 00 Transpertadeca

[ rest=_16.00 Pemsons Fora Fomeazs - |

o ] o || b |
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ApOs selecionar sera iniciado a gravagao, uma pequena tela ficara ativa,
permitindo Pausar (caso precise ajustar algo no ambiente) e clicar em Stop
quando concluir a gravagao

. $AT Sistermes Tegbas - BAT Sisterna de Automecio Tote - wosho 2106294

Versdes - Cadasiros . fxtoqoe  Entregs = bontagemn Firancern. Compras - Dusrde

EIEELILE IR

[ TertComplete Recardng @ %

o
S

Grave os passos informados no Roteiro de Homologacgao, apds concluir clique
em Stop. Sera adicionado um Script no teste escolhido.

[ #roectrer 203 % | T Worspece
REE A G- P stotpage (I Teste pa0n b % B oot Test Log [Teste 04,00 tbr,., X

~ 44% Project Suile ‘SATFunecedores” {1 projecs) |
“ [ sATFromecedores

L
H roCEdure TEsti]
Aichoanoad | o
it ?BE - war wodFrmMain o OleVariank;
B gin
w [ soet a wedFratain s= 2liatss. SAT wnoFrealng
53 0 - Testes Bisizon whdFratadn, Click(as, 2a};
llfl‘sln_ﬂ'l_m_,ﬁh‘r { wrdFrmttadn, MainHenu. Click 'Cadestros | [5] ")
w5 1 A - oo do Pomesedor [ L5
[ Tiesher 05 00 Prrminrs_Anticice
@mm_m_mm

Obs.: Lembre-se de salvar sempre que regravar um teste, menu File > Save
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Il - Gravando novos testes

Sempre que houver uma nova implementagao, devera ser adicionado o teste
tanto no roteiro quando o script no TestComplete, para isso selecione o bloco
de testes e clique com o botao direito do

O L ADE - LAS00T 00 MIENEosGoT
(5 Tt _0E 03 Proviairs_Antisice
[By Teste_oe_o0_Cancatsr
(B Teste_a7 00 Bter
(B Testn 0@ 00 Tnseri_Sabvar
[ Teste 05 00 Exrhar
[ Teste_t6 o)tz
[T Teste_11,00 Proosar
[ Teste_12 00 _tmoeimic
[ Teate_13 00 beny
[y Teste_t4 o0 Fechar
~ |5 2 fba - Crvderegn
[T Testa_15_00_Trarspertadora
[By Testa_15 00 Permissoes_Para_Fornecedares
[y Teste_17_ 00 Praencher_Campo_cEp
v 5 38ba - Obaervacoes
[Py Tests_12 00 Sbeervacoss CORRECAD
w 5 38ba - Contabe
[ Twstn_19_ 00, Cocion Cordiabd

mouse, em seguido Add > New Item

0 it TestLog [Teste 04 00_AberiTesti] DBS/21 19032128 |
€5 Serint Tewt Ung [Tt 04 00 Al Teesti] DS/O5T021 18:42:47

. *:m_a}_ﬂ o 3 g. Haw [been...
[ KinywordTests [ H Remaye [B  Eishag Hem.
B e e
[Fsar L2 Collpse Al CideAls
v?g’;twmw, o | B Expand Al Crdsdlted ¥ fest vemushoer
% soript Test Log [Teste 0400 At Testd} DS/ED01 19:04:08 | e [ st

elEszimisas e

Adicione o nome e cédigo do teste (o0 cédigo deve ser o mesmo do roteiro de

homologacgéo) e clique em Ok

Ehisns Tt

Seript Unit
Il A it wril.

roee [roste o | |

[

|5 2 Aba - Endenegn
[ Teeste 1500 _Trarspertadera
[Fy Teste_15_00_Permissoes_Para_Formeredores
[ Teste_17. om0 Preencher_Compo_cep
~ 5 3 Aba - Dbervscoes
[B Teste_15_00_Dbservacoes_CORRECAD
5 4 b - Contsbd
[ Tesbe_19_00_Cockpn, Cortabd
~ [ 5 &ba - Banco de Dados
(hreste modCrartompne. |
Chafeste Exerco
[5] KeypwardTests:
[ namebecpng
v [ Teshedapes
[ sar |
s < Project Suite Logs
w B oaTFomensdanes Logs
mw'ﬂ-ﬂlmm«h M4 O Aher iTenta] ARMEGENT1 108: 2900
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Agora para adicionar o Script, clique em “Record Script”

| Fle Edt Yew Tmt Debup Jook Pelp

e BRB-OC XABT - G64-BH|6]|8-man-

Praect Worpacs | e e \
R B TEAK (7 emae :

EEE A RS- i sietpase o (B
v 3 Advanced 3 |
» [hEvents

[ Teate_95_ 0% Priviee_Antivicr
[y Teste. e o0 Fancetar
[ Teste 07 00 Eciter
[T Teste 35 00 Tnserr_Saivar
(B Teste 05 o0 Swriar
[ Teste_10_0_snsizas
[By Teste_13 00 Procursr
[y Teste_12 o0 tmpeime
[ Teste 130 109
[By Tosts_i4 o0 Fachar
~ 5 2 ba - Enderacn
[l Teste_15_o00 Trampertasiorn
LR AV T A

Uma pequena tela sera aberta selecione o teste em questao e clique em OK

[ Tt 08 _00_insers_Sabvar x
[y Teste 0800 Exchir

[l Teste 103 00 _tnuszar

[ Tesst_13_00_pracisar

[ Teste_12_00_Imorimir

[ Teste_19.00_1og

[ B Teste_14 00 Fechar

[B Test=_15_ 00 _Transpoctadora

[ Teste_16,_00_Permissces_Para_Formeced
[ Teste_1700_Freencher_Campo CEF
[Fy Teste_18_00_obserracoss CORRECAD
I]*,rube m_m ww

tew T, |

e [ w

ApOs selecionar sera iniciado a gravagao, uma pequena tela ficara ativa,
permitindo Pausar (caso precise ajustar algo no ambiente) e clicar em Stop
quando concluir a gravagao

X

[ verComplets H.tmrdng a
Pwsa |

K

<

Grave os passos conforme descritos no Roteiro de Homologagao, apos concluir
clique em Stop. Sera adicionado um Script no teste escolhido.

Obs.: Lembre-se de salvar sempre que adicionar um teste, menu File > Save

FIM
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